
Nortel Communication Server 1000

Mobile Voice Client 2050
User Guide





Revision history

3

Revision history

May 2009

Standard 02.01. This document is up-issued to support 
Communication Server 1000 Release 6.0.

March 2007

Standard 01.01. This document is issued to support Nortel Mobile 
Voice Client 2050 Version 2.01 for Nortel Communication 
Server 1000. It is renumbered to NN42340-100 and contains 
information previously contained in the following legacy 
document, now retired: NN-10300-058.

August 2005

Standard 2.00. This document is issued to support Nortel Mobile 
Voice Client 2050 Version 2.00.0161 for Nortel Communication 
Server 1000.

March 2005

Standard 1.00. This document is issued to support Nortel Mobile 
Voice Client 2050 Version 2.00.0161 for Nortel Communication 
Server 1000. 



Revision history

4



Contents

5

Contents

About this guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Nortel Mobile Voice Client 2050 overview  . . . . . . . . . . . . . .  8

Software dependencies  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Supported PDAs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Headsets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10

MVC 2050 menus and screen features  . . . . . . . . . . . . . . . . .  11

Installing and configuring the Mobile Voice Client 2050  .  14

Removing a previous version of MVC 2050 . . . . . . . . . . . . . .  14

MVC 2050 installation method  . . . . . . . . . . . . . . . . . . . . . . . .  15

MVC 2050 configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17

MVC 2050 Call Handling screen  . . . . . . . . . . . . . . . . . . . . .  19

Starting the MVC 2050 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

Navigation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

Appearance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

MVC 2050 graphical interface (skins) components  . . . . . . . .  21

Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Icons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

Menu and icon summaries . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

Managing calls with Mobile Voice Client 2050 . . . . . . . . . .  38

Making a telephone call  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38

Answering a call . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

Holding a call  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

Retrieving a call  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

Ending a call . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39



Contents

6

Maintaining call quality . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

Managing Contacts with Mobile Voice Client 2050 . . . . . .  40

Editing the Contacts list  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

Accessing Contacts Help  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

Accessing the PDA Contacts list  . . . . . . . . . . . . . . . . . . . . . .  41

Dialing a number from the Contacts list  . . . . . . . . . . . . . . . . .  42

Dialing formats  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43

Personal Directory, Redial List, and Callers List . . . . . . . .  52

User preferences for Personal Directory, Redial List, and Callers 
List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  53

Call Log Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  54

Personal Directory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56

Call Log features: Redial List and Callers List  . . . . . . . . . . . .  57

Password Administration  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60

Mobile Voice Client 2050 settings . . . . . . . . . . . . . . . . . . . .  63

Sounds . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  63

Profiles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  66

Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  71

Macros  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  72

Mobile Voice Client 2050 for expert users . . . . . . . . . . . . .  76

Client diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  76

Audio quality . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  77

Listener IP  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81

Hardware ID . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  82

Connection history  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  84

WiFi  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  86



About this guide

7

About this guide

This User Guide provides information about the Nortel Mobile Voice 
Client (MVC) 2050.

The Nortel Mobile Voice Client (MVC) 2050 is designed to add wireless 
voice communication to the Personal Digital Assistant (PDA). 
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Nortel Mobile Voice Client 2050 
overview

Designed to work with your personal digital assistant (PDA) and IP-based 
telephone systems, the Nortel Mobile Voice Client (MVC) 2050 provides 
real-time voice service over the Internet. 

The MVC 2050 supports the following features:

• 6 programmable line/feature keys

• 4 soft keys (self-labeled)

• 12-button dialpad

• multifield display

• end user-selectable skins

• directory capabilities including Personal Directory, Redial List, and 
Callers List

To make a call from your PDA using the MVC 2050, you can dial with 
your dialpad, use a macro, or copy and paste a number from another 
application. You also can use one of the methods on your PDA System 
Input Panel. 

If you are using Microsoft® Windows Mobile™ 2003 Second Edition or 
Microsoft® Windows Mobile™ 5.0 for Pocket PC as your operating 
system, the MVC 2050 can also coexist with a secure Virtual Private 
Network (VPN) client for connection to a business network. 
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Software dependencies

The following are the MVC 2050 primary software dependencies: 

• Windows Mobile 5.0 for Pocket PC

• Windows Mobile 2003 for Pocket PC

• Windows Mobile 2003 Second Edition for Pocket PC

Note: Windows Mobile 2003 SE AKU1 is not supported (Version 
4.21.1088 (Build 14132)). AKU1 has a bug which makes it impossible 
for third parties to use Settings applets. This is resolved with WM2003 
SE AKU2 (Version 4.21.1088 (Build 14260.2.0.5)). 

• GIPS NetEQ (included with the MVC 2050 software)

• VPN client (for secure access to a network)

For secure (VPN) access to a network, a VPN client is required. 

Supported PDAs

The PDA industry evolves at a rapid pace. Refer to Nortel's web site 
(www.nortel.com/mvc2050) to determine the latest PDA models tested 
and any known issues.

Alternatively, follow the links on www.nortel.com to > Products > Phones, 
Clients, and Accessories > IP Phones and Clients > Mobile Voice Client 
2050 > Technical Specifications. 

For Nortel Technical Support use this link: http://www.nortel.com/support.

PDA processor models, speed, and amount of memory vary. To maintain 
audio quality, do not overload the processor with intensive tasks while 
using the MVC 2050. For example, Nortel does not recommend using 
your PDA Internet browser while using the MVC 2050.

MVC 2050 requires that PDAs meet the following mimimum technical 
specifications:

• screen resolution of 240x320
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• CPU speed of 624 MHz

• 64 MB RAM

PDA vendors offer two types of rechargeable battery: standard and 
extended-life. The extended-life battery is recommended to provide 
longer call duration and increased call volume.

Headsets

A headset is required in order to send and receive telephone calls using 
the MVC 2050 and your PDA. The headset is an important part of audio 
quality. 

PDAs that support stereo headphones with microphones are 
recommended.

The Dell specific headset with a button on the wire, when used with the 
X51v, allows the MVC 2050 to answer an incoming call or release an 
active call by pressing the button. 

Note: Bluetooth and 802.11b operate on the same frequency band 
and use the same WLAN hardware on the PDA. Therefore, the use of 
Bluetooth accessories with MVC 2050 can lead to poor call quality.

Contact your PDA vendor to obtain headset recommendations.

For more information about Automatic Gain Control, see “MVC 2050 
configuration” on page 17. 
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MVC 2050 menus and screen features

The MVC 2050 software provides menus and screen features for your 
PDA. Table 1 lists the MVC 2050 menus and their selections.  

The MVC 2050 supports both portrait and landscape modes. See “Call 
Handling screen (portrait)” on page 12 and “Call Handling screen 
(landscape)” on page 12. This landscape sample has the message 
waiting lamp displayed.

Table 1: MVC 2050 menus

Menu Selections

File Run in background, Paste, Contacts, Settings, 
Exit

Keys Answer, Goodbye, Hold, Features, Macros

Help Diagnostics, Contents, About

Note: Keys > Features and Keys > Macros selections in Table 1 also 
provide pop-up menus.
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Figure 1:  Call Handling screen (portrait)

Figure 2:  Call Handling screen (landscape)
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Table 2 describes the MVC 2050 screen features.

Table 2: MVC 2050 screen features

Screen features Selections

Call Handling icons Hold, Answer, Release

Toolbar (portrait) The retractable toolbar is present only on the 
portrait skin. It contains keys that are not 
present on the remainder of the display. 

They are: Directory, Messages, Shift, 
Services, Expand, Copy, Exit, Redial List, and 
Callers List. 

The toolbar can be shown or retracted using 
the Toolbar icon on the menu bar. See 
Figure 6 on page 20.

Mute, Volume Up, and Volume Down icons 
are also present on the Toolbar, and appear 
on the skin when the Toolbar is retracted.

Toolbar (landscape) The landscape skin has most of the 
retractable buttons on the normal (non-
retractable) toolbar, some on the skin (Mute, 
Volume Up, and Volume Down) and the 
remainder (Settings, Contacts, and Paste) 
available from menu items. See Figure 2 on 
page 12.

Toolbar icons Directory, Messages, Shift, Services, Expand, 
Copy, Quit, Callers List, Redial List

Menu Bar icons Paste, Contacts, Settings, Toolbar

Navigation The up, down, left, and right cursor control 
arrow keys are mapped to the hardware 
navigation buttons on the PDA hardware. 
These buttons are used for cursor control.
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Installing and configuring the 
Mobile Voice Client 2050

To install MVC 2050 on your PDA:

1. If you have an older version of MVC 2050 installed on your PDA, you 
must remove it prior to installing a newer version. See “Removing a 
previous version of MVC 2050” on page 14.

2. Place your PDA in its cradle.

3. Synchronize your PDA with a desktop PC running Microsoft 
ActiveSync®. See “Connecting a PDA to a desktop PC using 
ActiveSync” on page 15.

4. Install the MVC 2050 from a Desktop. See “Installing the MVC 2050 
from a Desktop PC using ActiveSync” on page 16.

Removing a previous version of MVC 2050

If a previous version of the MVC 2050 is installed on your PDA, delete the 
old version before installing the new one, or the installation fails. See 
Figure 3 on page 15.

Use the following procedure to remove the MVC 2050 from your PDA:

1. Select Start from the Main Application screen. A drop-down menu 
appears.

2. Select Settings. The Settings dialog box appears.

3. Select the System tab. The System dialog box appears. 

4. Select Remove Programs. A list of programs appears.

5. Select Mobile Voice Client 2050.

6. Select Remove. A dialog box appears, asking you to confirm this 
decision.

7. Select Yes. A brief pause occurs while the PDA removes MVC 2050. 
After the pause, a dialog box appears asking if you want to perform a 
soft reset.

8. Select Yes. Your PDA restarts.



Installing and configuring the Mobile Voice Client 2050

15

Figure 3:  Removing MVC 2050

MVC 2050 installation method

The MVC 2050 supports installation from a docked PDA with a Microsoft 
ActiveSync connection to a desktop PC.

Connecting a PDA to a desktop PC using ActiveSync
Use the following procedure to synchronize your PDA to your 
desktop PC:

1. Place your PDA in its cradle.

2. Ensure that ActiveSync is running. Connection is confirmed on the 
ActiveSync screen.

3. Wait for the two PCs to synchronize. Synchronization is confirmed on 
the ActiveSync screen.

See Figure 4 on page 16. For details about synchronization, refer to the 
User Manual for your PDA.
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Figure 4:  ActiveSync connected

Installing the MVC 2050 from a Desktop PC using 
ActiveSync
Use the following procedure to install MVC 2050 using the CD:

1. Insert the MVC 2050 CD into the CD-ROM drive of your desktop PC.

2. Go to your desktop, and double-click My Computer.

3. Select the CD Drive.

4. Select Setup.

5. Follow the instructions on the screen. The Install Wizard displays a 
message asking you if you want to modify, install, or remove the 
MVC 2050.

6. Select Install. The Install Wizard installs the MVC 2050. When the 
installation finishes, a message appears on the PC’s display 
requesting that you attend to your device (PDA), and a message 
appears on the PDA’s display asking you if you want to perform a soft 
restart.

7. Select Yes. Your PDA restarts with the new version of the MVC 2050.
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MVC 2050 configuration

Enable ClearType
The MVC 2050 uses a special screen font, which requires that 
ClearType® be enabled on your PDA. 

To enable ClearType:

1. From the PDA’s Main Application screen, select Start.

2. Select Settings.

3. Select Screen. 

4. Select Enable Clear Type.

Automatic Gain Control
Since the MVC 2050 requires a headset to operate properly, disabling 
Automatic Gain Control is sometimes necessary to attain optimum audio 
quality. 

Note: When the PDA is used in handsfree mode, without a headset, 
the PDA microphone picks up sounds from the speaker, creating a 
feedback loop. Automatic Gain Control is used in this instance to 
avoid feedback. For further information about device hardware 
settings, see your PDA Help system.

To disable Automatic Gain Control:

1. Select Start.

2. Select Settings.

3. Select System.

4. Select one of the following, depending on the PDA you are using:

a.  Audio

b.  Advanced Sounds

c.  Microphone 

5. Select Automatic Gain Control.
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6. Select Disable.

7. Select Yes.

For further information about MVC 2050 configuration and settings, see 
the MVC 2050 Help system.
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MVC 2050 Call Handling screen

Starting the MVC 2050

To start the MVC 2050 from your PDA:

1. From your PDA Main Application screen, select Start.

2. Select Programs. See Figure 5.

3. Select Mobile Voice Client 2050. The Call Handling screen appears. 
See Figure 6 on page 20.

Figure 5: Starting MVC 2050 from Main Application screen

AAA1211a.bmp
AAA1211b.bmp
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Figure 6: Call Handling screen
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pocket PC screens, and flat panel monitors. See “MVC 2050 
configuration” on page 17 for information about enabling ClearType.

MVC 2050 graphical interface (skins) 
components

The MVC 2050 skins are the graphical representation of the MVC 2050. 
The dialpad, menu, and icon buttons are located on the skin. Skins come 
in several colors and arrangements. 

To select a skin:

1. Select Settings.

2. Select Skin.

3. Select a skin from the list.

All skins share the following common components. See Figure 7 on 
page 22.

• programmable line/feature keys

• soft keys (self-labeled)

• dialpad

• display

• Call Handling icons

• Toolbar icons

• Menu Bar icons

• retractable toolbar

• System Input Panel icon

See the following examples of the MVC 2050 skins: Figures 7 to 9 starting 
on page 22 and Figure 16 on page 32.
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Figure 7: Black skin

Figure 8: Blue skin
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Figure 9: Lime skin

Display
The display is located in the central area of the skin. See Figure 6 on 
page 20.

Programmable line/feature keys
Six programmable line/feature keys are located on the right side of the 
skin. They are aligned vertically and are the same color as the display. 
See Figure 6 on page 20.

Soft keys (self-labeled)
Four soft keys (self-labeled) are located in the bottom row of the display 
area. See Figure 6 on page 20.

Note 1: The label on the key changes, based on the active feature.

Note 2: A triangle before a key label indicates that the key is active.
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Dialpad
The 12-button dialpad is located on the left-hand side of the skin. See 
Figure 6 on page 20.

Message Lamp 
The Message Lamp lets you know if you have voicemail waiting. See 
Figure 6 on page 20. 

Mute Indication Lamp
The color of the Mute button changes to red when the call is muted. The 
Toolbar must be retracted to see this indicator. because the Toolbar icon 
for Mute does not change color when the microphone is muted. See 
Figure 6 on page 20.

Menus

The MVC 2050 provides the following menus:

• File

• Keys

• Help

File
The following items are available from the File menu:

• Run in background

• Paste

• Contacts

• Settings

• Exit

See Figure 10 on page 25.
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Figure 10: File menu

Run in background 
Select Run in Background to close the MVC 2050 and to keep it running 
in the background so that incoming calls can ring on your PDA. 

To accept an incoming call while the MVC 2050 is running in the 
background:

1. From the Main Application screen, select Start.

2. Select Recently Used Application.

Note: You can also select Start > Today or Start > Home, 
depending on your PDA. When you select Start > Today or 
Start > Home, the MVC 2050 icon appears in the lower right corner 
of this screen.

After you have completed your call, press the “X” in the upper right-hand 
corner of the PDA display to close the application. See Figure 10. This 
returns the MVC 2050 to Run In Background mode.
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Paste
Select Paste to paste a telephone number, copied from another 
application, into the MVC 2050. You can do this to place a call rather than 
entering it through your Call Handling screen dialpad.

Contacts
Select Contacts to launch the Contacts dialog box. The Contacts 
application reads a list of contacts from the PDA Contacts list. The PDA 
Contacts List application normally can be synchronized with Outlook on 
your desktop PC.

Settings
The following items are available on the File > Settings submenu: 

• Profiles

• Server

• Skin

• Features

• Macros

• Audio

• About

• Language

• Hardware ID

• Advanced Audio

• Listener IP

• Sounds

For more information about Settings, see “Mobile Voice Client 2050 
settings” on page 63. 

Exit
Select Exit to close the MVC 2050. Once you select Exit, you cannot 
place or receive calls until you restart the application. For more 
information, see “Run in background” on page 25.
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Note: Selecting Exit frees up PDA processing resources.

Keys
The following items are available from the Keys menu:

• Answer

• Goodbye

• Hold

• Features

• Macros

Figure 11:  Keys menu

Answer
Select Answer to answer an incoming call, or to obtain a dial tone to 
place a call. See also the Answer icon, top center in the Call Handling 
screen.
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Goodbye
Select Goodbye to end your call. See also the Goodbye icon, top right in 
the screen.

Hold
Select the Hold menu item to place a call on hold. See also the Hold 
icon, top left in the Call Handling screen.

Features
Select Features to access a menu of interface keys. The list of available 
features varies depending on the type of communication server you are 
connected to.

• See Figure 12 on page 29 to access the Features submenu from the 
Keys screen. 

• See Figure 13 on page 29 to access the Features menu from the 
Settings screen.

The following are the default Features:

• Message

• Shift

• Directory

• Services

• Expand

• Copy

• Quit

• Redial List

• Callers List

Items in Features submenu can be reorganized using the Settings > 
Features tab; however, items cannot be added or removed.
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Figure 12: Keys > Features screen

Figure 13:  Settings > Features screen  

AAA1200.bmp
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Macros
Select Macros from the Keys menu to access macros available through 
the Settings > Macros dialog box. You can use macros to make speed 
dial calls, access voicemail, and perform routine functions faster and 
easier (see “Macros” on page 72).

Help
The following items are available from the Help menu:

• Contents

• Diagnostics

• About MVC 2050

MVC 2050 offers a PDA-specific version of Help, shown in Figure 14.

Figure 14: Help menu 

Contents
Select Contents to access the MVC 2050 Help system.
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Diagnostics
Diagnostics provides access to a list of methods to determine server 
connection state.

To access Diagnostics:

1. Select Help.

2. Select Diagnostics to see the following items in the drop-down list. 

— Ping

— Trace Route

— RUDP Ping

About MVC 2050
Select About MVC 2050 to see the MVC 2050 system product name, 
version number, copyright indication, Nortel name and logo, and Global 
IP Sound® name and logo. The MVC 2050 uses packet loss concealment 
provided by Global IP Sound NetEQ™ software. 

Figure 15:  About screen
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Icons

See Figures 16 to view the icons available in the MVC 2050.

Icons can be divided into three types:

• Call Handling icons

• Toolbar icons

• Menu Bar icons

Figure 16:  Call Handling screen
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Call Handling icons
The Call Handling icons are:

• Hold

• Answer

• Goodbye

These Call Handling icons are located at the top of the skin. See 
Figure 16 on page 32.

Hold
Use the Hold icon to place calls on Hold and to remove them from Hold.

Answer
Use the Answer icon to receive and to place calls. 

Goodbye
The Goodbye icon is used to terminate calls.

Toolbar icons
The Toolbar icons are: 

• Directory

• Messages

• Shift

• Services

• Expand

• Copy

• Quit

The Toolbar icons are visible when the Toolbar is retracted. See 
Figure 16 on page 32.
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Note 1: Select Keys >  Features to view menu items that are exact 
equivalents to tapping these Toolbar icons. 

Note 2: Volume Up, Volume Down, and Mute (which are covered 
when the Toolbar is shown) also are repeated on the Toolbar. 

Directory
The Directory icon, depending on how your system administrator has set 
up this service, allows access to a local directory, the Personal Directory 
with up to 100 entries, Password Administration, or some other server-
based directory service.

Select the Directory icon to place a call. Directory accessibility depends 
on the system to which you are connected.

Inbox/Messages
Select the Inbox/Messages icon to access your messages, or to return a 
call.

Outbox/Shift
Select the Outbox/Shift icon to shift between sets of programmable line/
feature keys. 

Services
Select the Services icon to access a list of network services. 

Expand
Select the Expand icon to access additional services, depending on the 
system to which you are connected. 

Copy
Select Copy to add contacts to the Personal Directory by copying entries 
from the Redial List, the Callers List, or other directory applications. 
Availability of the Copy feature depends on which type of communication 
server to which you are connected, and on how your system administrator 
has set up the Directory service.

Note: If you are creating multiple entries in the Personal Directory, 
you can make and edit multiple copies in an existing entry. 
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Quit
Select the Quit icon to exit a network service or feature.

Callers List
The Callers List icon provides access to information on up to 100 
telephone numbers of calls received.

Redial List
The Redial List icon provides access to information on up to 20 
telephone numbers you have dialed recently.

Menu Bar icons
The Menu Bar icons are:

• Paste

• Contacts 

• Settings 

• Toolbar toggle

• System Input

Paste
Use the Paste icon to paste a number from another application to the 
MVC 2050.

Contacts List
Use the MVC 2050 Contacts List icon to view, select, and dial contacts. 
The MVC 2050 Contacts List is a read-only list available from the PDA 
Contacts List. To add, modify, or delete entries, use the PDA Contacts 
application. The PDA Contacts List can also be updated by 
synchronizing it with your deskptop’s Outlook directory, using Microsoft® 
ActiveSync®. See your PDA user guide for a description of this feature. 

Settings
Select the Settings icon to view the Settings screens. See “Mobile Voice 
Client 2050 settings” on page 63.
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Toolbar
Select the Toolbar icon to toggle the Toolbar display on and off. 

System Input
The System Input icon in the system tray at the bottom right-hand corner 
of the PDA, shown in Figure 16 on page 32, provides access to the 
System Input Panel. Consult your PDA documentation for a description 
of the System Input Panel.

You can use the System Input Panel to enter data for the MVC 2050 and 
other applications. 

The following are three methods you can use to input data on your PDA: 

• Keyboard

• Letter Recognizer

• Block Recognizer

Using the MVC 2050 application, the PDA keyboard can act like a 
dialpad. For instance, the alphabetical J, K, or L is interpreted as a 
number five (5). Keys that are not alphanumeric are ignored. .

Menu and icon summaries

File menu
Table 3 summarizes the File menu selections. 

Table 3: File menu  (Part 1 of 2)

Selection Description

Run in Background Closes the MVC 2050 application, but leaves it 
running in the background to allow incoming 
calls to be received.

Paste Pastes a telephone number into the call 
interface to place a call (also available as a 
Menu Bar icon).
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Keys menu
Table 4 summarizes the Keys menu selections. 

Help menu
Table 5 summarizes the Help menu selections. 

Contacts Opens the Contacts List (also available as a 
Menu Bar Icon).

Settings Provides access to the Settings dialog boxes 
(also available as a Menu Bar Icon).

Exit Shuts down the MVC 2050 application (also 
available as a Menu Bar Icon).

Table 4: Keys menu

Selection Description

Answer Answers an incoming call or provides a dial tone so 
you can make a call (also available as the Answer 
icon located at the top center of the display).

Goodbye Releases the call. 

Hold Places the current call on hold (also available as the 
Hold icon at the top left of the display).

Features Presents a menu of available features.

Macros Presents a menu of the programmed macros.

Table 5: Help menu

Selection Description

Contents Accesses the Help system.

Diagnostics Provides access to MVC 2050 diagnostics.

About Provides information about your MVC 2050 system.

Table 3: File menu  (Part 2 of 2)

Selection Description
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Managing calls with 
Mobile Voice Client 2050

Making a telephone call 

Use the following procedure to make a call from your PDA using the 
MVC 2050: 

1. Plug the headset into the PDA, and put the headset on.

2. Select Mobile Voice Client 2050 from the Start > Settings/System 
menu or Start > Programs menu.

3. Open the line by selecting one of the following:

— Answer icon

— Answer key from the Keys menu

— a line key

4. Dial the number by using one of the following: 

— dialpad

— macro

— Contacts within the MVC 2050 interface

— network Directory 

— Personal Directory

— Callers List

— Redial List

— Paste icon or menu item to paste a number copied from another 
application

— a PDA System Input Panel such as the keyboard, block 
recognizer, or letter recognizer
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Answering a call 

Use the following procedure to answer a call from your PDA:

1. Select one of the following:

— Answer icon 

— Answer key from the Keys menu

— ringing line key

2. Speak into your headset microphone.

Holding a call 

Select the Hold icon, or select Hold from the Keys menu, to place a call 
on hold.

Retrieving a call 

Select the line key to retrieve a call from Hold.

Ending a call 

Select the Goodbye icon, or select Goodbye from the Keys menu, to 
end your call. 

Maintaining call quality

If you are experiencing poor quality during a call on the MVC 2050, move 
closer to the WLAN access point. Distance from the access point reduces 
the throughput/data rate. 

Using MVC 2050 on a PDA in a closed area or indoors also reduces the 
throughput, compared to open space. 

Bluetooth and 802.11b operate on the same frequency band and use the 
same WLAN hardware on the PDA. Therefore, the use of Bluetooth 
accessories with MVC 2050 can lead to poor call quality.
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Managing Contacts with 
Mobile Voice Client 2050

You can place a call from your list of contacts in the PDA Contacts 
application using Mobile Voice Client (MVC) 2050. See Figure 17.

Use the Contacts application to do the following:

• add or modify entries on the PDA

• download entries from the Outlook contacts on your PC

• use the infrared ports on two PDAs to transfer entries between them 
(beam)

Figure 17:  Starting Contacts and the Contacts application 
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Editing the Contacts list

See the Contacts Help on your PDA for information about adding, 
deleting, and editing Contacts. 

See the appropriate Help screen for information on editing the Contacts 
in Outlook on your desktop PC.

Accessing Contacts Help

Use the following procedure to access your PDA Contacts Help system:

1. Select Start. A drop-down list appears.

2. Select Contacts. The Contacts screen appears.

3. Select the word Contacts at the top of the screen. The drop-down list 
appears.

4. Select Help. The Contacts Help screen appears.

Accessing the PDA Contacts list

Use the following procedure to access your PDA Contacts list:

1. Open the PDA Today or Home screen.

2. Select Start > Contacts. The Contacts read-only screen appears.

Note: To view the Contacts list within the MVC 2050, select 
File > Contacts. See Figure 18 on page 42.
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Figure 18:  MVC 2050 Contacts screen

Dialing a number from the Contacts list

Use the following procedure to dial a number from the MVC 2050 using 
the Contacts list:

1. Select File > Contacts. The Contacts list appears.

2. Double-tap the name or number you want to dial. The Phone details 
dialog box appears. See Figure 19 on page 44.

3. Use the Phone details dialog box to modify the number to be dialed, 
as needed.

4. To dial the number, press the check mark in the lower left-hand 
corner of the display. See Figure 19 on page 44.
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Dialing formats

Numbers must be in the canonical dialing format in order for your PDA to 
use them for dialing. 

The canonical address format is a universal telephone number format 
recognized by the WIndows Telephony Application Interface (TAPI).

The canonical format identifies the components of a telephone number, 
which TAPI translates according to a country’s or region’s dialing rules. 
The canonical format is:

+ Country/Region Code (Area Code) Subscriber number

Note: For further information on canonical dialing, refer to the 
Microsoft web site.

When you select File > Contacts and double-tap a number to dial from 
the contacts list, the Phone details dialog box appears, shown in 
Figure 19 on page 44. The dialog box provides options for the criteria to 
properly route your call. 

Use the Phone details dialog box to:

• modify the number being dialed

• select or deselect canonical dialing rules

• interpret the number as a private network (ESN) number
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Figure 19: Phone details dialog box

The following are the components for creating and using canonical dialing 
numbers:

• area code, in the Contacts application

• dialing properties, called Dialing Locations (see Figure 20 on 
page 45)

Note: Information in the Dialing Locations tab indicates the origin of 
the call.

553-AAA1529
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Figure 20: Dialing locations
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Set the patterns for local, long-distance, and international dialing using 
Dialing Patterns. See Figure 21.

Figure 21: Dialing patterns

Area code
Set the Area code to provide the default area code for dialed numbers.

To establish the default Area code:

1. Select the PDA Contacts > Tools > Options.

2. Assign the correct value to the Country/Region and Area code.

See Figure 20 on page 45.

553-AAA1534
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The Contacts application prefixes the default area code to numbers you 
enter in your Contacts application. The PDA attempts to interpret the 
numbers as canonical. 

For example: enter a seven-digit number. Contacts assumes that the 
number is in your area code, and the software adds the area code as a 
prefix to the seven-digit number to create a canonical number.

In North America, if you enter a default area code of “415” in your 
Contacts and then enter the number “555-1212”, the following occurs:

• Contacts prefixes the area code to the number

• the displayed number changes to “(415) 555-1212”

This number is interpreted as a canonical number that the PDA can use 
for dialing.

Dialing Locations
Dialing Locations describe the dialing rules to be applied when you dial a 
number. The dialing rules allow you to enter prefixes to access local and 
long-distance numbers. Use the location of your server. See Figure 20 on 
page 45.

To establish the dialing rules:

• Select Start > Settings > Connections > Dialing Locations.

• Enter your server’s Area Code.

• Enter your server’s Country Code.

• Specify Tone dialing.

• Select Dialing Patterns.

• Enter or modify the dialing patterns for local calls, long-distance calls, 
and international calls.
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Example
An end user has a DN on a server located in Atlanta and another DN on a 
server located in New York. The end user has set up two dialing 
locations: one named “Atlanta”’, with an area code of 404, and another 
named “New York”, with an area code of 646. The end user also has 
entered ‘646’ as the default area code in the Contacts application. 

The end user also has programmed Dialing Patterns as follows:

• for local calls, dial: 9,G

• for long-distance calls, dial: 6,1FG

• for international calls, dial: 6,011,EFG

Note:  According to the Dialing Patterns dialog, E means insert 
country code, F means insert area code, and G means insert the 
number. Insertion of “,” (a comma) indicates a one half-second 
pause. 

— With the location of New York selected, the end user enters 
information for a contact whose business number is 555-1212. 
The Contacts application uses the Contacts Area code to 
determine the area code default (646).

— With the location of New York selected, the end user enters 
information for a contact whose business number is 416-555-
1212. The end user enters all ten digits to record the number in 
Contacts as (416) 555-1212.

— With the location of New York selected, when the end user 
selects 555-1212 in the MVC 2050 Contacts list, and selects Dial 
Business, the Phone details dialog box appears and displays the 
number to be dialed as 9,5551212. 

— With the location of New York selected, when the end user 
selects 416-555-1212 in the MVC 2050 Contacts list, and selects 
Dial Business, the Phone details dialog box appears and displays 
the number to be dialed as 6,4165551212.

— With the location of Atlanta selected, when the end user selects 
555-1212 in the MVC 2050 Contacts list, and selects Dial 
Business, the Phone details dialog box appears and displays the 
number to be dialed as 9,16465551212.
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See your PDA Help system for a description of the values used in dialing 
patterns.

ESN numbers
To enter ESN numbers in Contacts, enter the ESN prefix followed by the 
number.

Note: PDA Contacts does not accept the ‘~’ character used in the 
IP Softphone 2050 to express ESN numbers. You can provide a ‘~’ 
character to your PDA Contacts application by storing a ‘~’ character 
prefix digit in your PC Outlook Contacts. Then use ActiveSync to 
synchronize your PDA with your PC Outlook. This transfers the ‘~’ to 
your PDA. 

To assign the ESN prefix:

1. Dial a number using the Contacts list. 

2. When the Phone details dialog box appears, select ESN, and enter 
or modify the ESN prefix in the box.

See Figure 22 on page 50.
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Figure 22: ESN dialing

Extension numbers
The PDA Contacts application dials extension numbers only if they do not 
satisfy Microsoft criteria for numbers that require an area code. 

The following three methods can be used to manage dialing extension 
numbers:

1. Select Extension in the Phone details dialog box. See Figure 23 on 
page 51. 

2. Enter extension numbers in your PC Outlook Contacts application, 
and ActiveSync your PC Outlook with your PDA Contacts.

3. Select Keys > Macros, and enter the direct dial extension number in 
a macro. See “Macros” on page 72 for information about macros.

553-AAA1532
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Figure 23: Extension number

553-AAA1531
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Personal Directory, Redial List, 
and Callers List

Personal Directory, Redial List, and Callers List are features supported on 
CS 1000 systems running CS 1000 Release 4.0 software. The contents 
of these directories are maintained in a remote, central database called 
the Application Server. 

To open Personal Directory, Redial List, or Callers List:

1. Tap the Directory icon.

2. Make your selection from the following list:

— Personal Directory

— Callers List 

— Redial List 

— Password Administration 

Note: The Personal Directory, Redial List, and Callers List features 
have a one-minute timeout control period. If the application is idle for 
one minute during any of the operations, the application is closed, 
and your IP Softphone 2050 goes back to the idle state.

The Personal Directory, Redial List, and Callers List features support:

• multiple languages

• access using the Directory key

• feature launch while in Call Transfer and Conference modes (your 
MVC 2050 does not have to be idle)

• Branch Office in normal mode only

• Virtual Office

• menu-driven configuration of Station Control Password (SCPW) from 
your IP Softphone

• database backup and restoration by your system administrator

• system administrator functions, such as unlocking your SCPW
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• system administrator restoration of profiles for single, multiple, or all 
users

User preferences for Personal Directory, 
Redial List, and Callers List

The following is a list of options you can change:

• language

• date/time display format

• call timer

• name display format

• call log options

— log all/unanswered calls

— area code setup

— preferred name match

— new call indication

To set user preferences:

1. Tap the Services icon.

2. Tap Telephone Options.

3. Select one of the following:

— Language

— Date/time

4. Scroll down the list.

5. Tap your selection.

6. Tap Select or Cancel.
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Call Log Options

The following is a list of Call Log Options:

• Log all/unanswered incoming calls

• New call indication

• Preferred name match

• Area code set-up

• Name display format

Table 6 describes the Call Log Options.  

Table 6: Call Log Options (Part 1 of 2)

Call Log Option Description Default value

Log all/unanswered 
incoming calls

Callers List logs all of 
the incoming calls or 
only the unanswered 
incoming calls. 

Log all calls

New call indication Telephone displays a 
message indicating that 
a new incoming call 
was received.

On

Preferred name 
match

If set to Off, the CPND 
from the Call Server is 
displayed for an 
incoming call. If set to 
On, the name stored in 
the Personal Directory 
is displayed, if a match 
is found.

Off
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To set Call Log Options:

1. Tap the Services button.

2. Tap Telephone Options.

3. Tap Call Log Options.

4. Tap one of the following:

— Incoming Calls

— Preferred Name Match

— Area Code Setup

— Name display format

5. Scroll through the selected list.

6. Tap your selection.

7. Tap Select or Cancel.

Area code set-up Incoming call phone 
numbers display in the 
order you set, if the 
area code matches one 
of the three that you 
have set up. Example: 
area code first or area 
code last.

No area code 
specified

Name display format You can define the 
format of the name 
displayed for incoming 
calls. The options are: 
first name/last name or 
last name/first name

First name/last 
name

Table 6: Call Log Options (Part 2 of 2)

Call Log Option Description Default value
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Personal Directory

You control your own Personal Directory. You can create up to 100 
entries. You can edit, copy, or delete individual entries, or delete the 
entire list, and you can copy entries from other applications to Personal 
Directory, or from Personal Directory to other applications.

The following list describes the contents of a Personal Directory entry:

• last name (up to 24 characters)

• first name (up to 24 characters

• DN at work (up to 31 characters)

• DN at home (up to 31 characters

• cell phone (up to 31 characters)

• pager (up to 31 characters)

To add a contact to Personal Directory:

1. Tap the Directory icon.

2. Tap Personal Directory.

3. Tap the Add key to start a text editor.

4. Enter the contact information. 

Note: You can tap the Pause soft key any time during data entry to 
add a pause in the number.

5. Tap Done to submit the entry. 

You also can add contacts to the Personal Directory by copying entries 
from the Corporate Directory, the Redial List, the Callers List, or other 
available directory applications. If you are creating multiple entries in the 
Personal Directory, you can make and edit multiple copies of an existing 
entry.

To edit a contact in the Personal Directory:

1. Tap the Directory icon.

2. Select Personal Directory from the Directory list.
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3. Search for the desired entry.

4. Highlight the entry.

5. Tap the Edit soft key and make the changes.

6. Tap the Done soft key.

You can temporarily edit contacts in the Redial List and the Callers List, 
then dial the edited entry. The changes are not retained.

To dial from the Personal Directory:

1. Tap the Directory icon.

2. Scroll to the Personal Directory.

3. Tap Personal Directory.

4. Find the contact by one of the following:

— Scroll to the desired contact.

— Search for the contact by name or number.

— Enter the number of the contact to find it.

5. Double-tap the contact to dial the selected entry.

Call Log features: Redial List and Callers List

Redial List and Callers List are Call Log features. The content of Redial 
List and Callers List is generated by the system during call processing. 
You can delete individual entries, or the entire directory, in Redial List and 
Callers List, but you cannot add an entry or permanently change the 
content of an entry.

Callers List
The Callers List can contain up to 100 entries. When the list is full, the 
system overwrites the oldest entry. 

In Directory View mode, the caller’s name displays along with the Callers 
List entry count. Entries in the Callers List are sorted by Call Log time. 
The first entry you see is the first new entry. If you press the down 
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navigation key, more new items in the Callers List display. If you press the 
up navigation key, an older item in the list displays. 

The following list describes the contents of a Callers List entry:

• last name (24 characters)

• first name (24 characters)

• DN (31 characters)

• time/date

• number of calls

Dialing from the Callers List
To dial from the Callers List:

1. Do one of the following to open Callers List:

— Tap the Callers List icon on the Toolbar.

— Tap the Directory icon and tap Callers List.

2. Find the contact by one doing of the following:

— Scroll to the desired contact.

— Search for the contact by name or number.

— Enter the number of the contact. 

3. Double-click the contact to dial the selected entry.

Redial List
The Redial List can contain up to 20 entries. When the list is full, the 
system overwrites the oldest entry.

In Directory View mode, the number you dialed is displayed. Redial List 
content is updated when you dial out. Entries in the Redial List are sorted 
by Call Log time. The oldest entry is at the beginning of the list. Press the 
down navigation key to go to the newest entry, and press the up 
navigation key to go to the oldest.
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The following list describes the contents of a Redial List entry:

• username (up to 24 characters)

• directory number (up to 31 digits)

• time of the last call occurrence

• time/date

Dialing from the Redial List
To dial from the Redial List:

1. Do one of the following to open Redial List:

— Tap Redial List on the Toolbar.

— Tap the Directory icon and tap Redial List.

2. Find the contact by one doing of the following:

— Scroll to the desired contact.

— Search for the contact by name or number.

— Enter the number of the contact to find it.

3. Double-tap the contact to dial the selected entry.

To temporarily edit a contact, and dial it using the Redial List or the 
Callers List:

1. Tap the Directory icon.

2. Select Redial List or Callers List from the Directory list.

3. Search for the desired entry.

4. Highlight the entry.

5. Tap the Edit soft key, and make the changes.

6. Tap the Dial soft key to dial the edited entry.

To find contacts in Personal Directory, Redial List, or Callers List:

1. Tap the Directory icon.

2. Tap the desired directory, and do one of the following:

— Scroll through the directory to the desired entry. 

— Enter the number of the entry to go directly to it.
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— Search by first name, last name, or number.

To delete a contact in Personal Directory, Redial List, or Callers List:

1. Tap the Directory icon.

2. Select the Personal Directory, Redial List, or Callers List.

3. Search for the entry.

4. Highlight the entry.

5. Tap the Delete soft key.

6. Tap the Confirm or Cancel key.

To delete the Redial List or Callers List:

1. Tap the Directory button.

2. Select Redial List or Callers List.

3. Tap the Del soft key.

4. Tap Yes.

Password Administration

The Password Administration feature is available on the Directory list. 
The Station Control Password (SCPW) protects your private directory 
information. You can perform Password Administration from your 
MVC 2050, once your SCPW is defined by your system administrator on 
the Call Server. Password Administration includes turning on or off 
password protection and changing your password.

When password protection is enabled, authentication is required before 
you can access Personal Directory, Redial List, or Callers List. You are 
prompted to enter your password in order to gain access to any of the 
password-protected features, such as Personal Directory, Redial List, 
Callers List, or Virtual Office.

Note: The default setting for Password Protection is Off.
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To turn Password Protection On/Off:

1. Tap the Directory icon.

2. Select Change Protection mode.

If Password Protection is enabled, you are prompted to enter your 
password.

3. Tap one of the following:

— Ent to confirm

— Del to delete your password

— Clr to clear your password

— Can to cancel and return to the Directory list

4. If you tapped Ent, select one of the following:

— Enable Pwd Protection

— Disable Pwd Protection

5. Tap one of the following:

— Yes to accept your selection

— No to return to the Directory list

6. If you selected Yes, tap Done to enable or disable Password 
Protection.

To change your password:

1. Tap the Services icon.

2. Select Telephone Options (you are prompted to enter your 
password).

3. Enter your password.

4. Select New Password.

5. Tap one of the following:

— Sel to select New Password

— Del to return to the previous menu

— Clr to clear your password
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— Can to end

If you tapped Sel, you are prompted to enter a new password.

6. Enter your new password and tap Sel. You are prompted to confirm 
your new password.

7. Tap one of the following:

— Sel to select New Password

— Del to return to the previous menu

— Clr to clear your password

— Can to end

If you tapped Sel, your password is changed.

If you make three consecutive incorrect password attempts within an 
hour, you are locked out of the password-protected features for an hour. 
“Locked access” displays on your telephone. 

If Virtual Office is enabled, it also is locked out. If you fail to access Virtual 
Office due to incorrect password attempts, your access to other 
password-protected features also is locked out.

Your system administrator can reset and unlock your access at any time, 
if you have been locked out or have forgotten your password.
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Mobile Voice Client 2050 settings

Use the MVC 2050 Settings to select choices for the appearance, 
behavior, and operation of your PDA. The Settings tab provides access 
to the following selections:

• “Sounds” on page 63

• “Profiles” on page 66

• “Server” on page 71

• “Macros” on page 72

• Skin

• Features

• Audio

• About

• Language

• Hardware ID

• Advanced Audio

• Listener IP

This section provides information about setting sounds to accompany 
events, profiles creation and use, server assignment, and macro creation 
and use. 

Sounds

The Mobile Voice Client (MVC) 2050 can make sounds to indicate server 
connection or disconnection.

Sound files and sound settings are not saved or transmitted between 
device infrared ports (beamed) when profiles are saved or beamed. 
Therefore, the sounds must be programmed by the user. 
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Audible notification of server connection or 
disconnection
You can program sounds to accompany notification of server connection 
or disconnection events.

To program up to three sounds for use with audible notification of server 
connection or disconnection:

1. Select File.

2. Select Settings.

3. Select Sounds.

Figure 24: Sounds - server connected 

Sounds are used for the following events (See Figure 25 on page 65):

• Server unreachable

• Server unresponsive

• Server connected

AAA3292
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Server unreachable
The sound you select for this event plays when MVC 2050 loses contact 
with the server. The message “Server unreachable” displays on the PDA 
screen.

Server unresponsive
The sound you select for this event plays if MVC 2050 fails to connect to 
the server. The message “Server unresponsive” displays on the PDA 
screen. 

Server connected
The sound you select for this event plays when MVC 2050 connects to a 
server. The message “Server connected” displays on the PDA screen.

Figure 25: Events list
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Profiles

Each profile is a named file that contains a combination of servers and 
other attributes that control the connection, behavior, and appearance of 
the MVC 2050. 

A number of profiles can be created and saved to allow easy switching 
among different servers, feature programming, and audio programming. 

Profiles can be created, selected, or deleted. Once selected, the name of 
the profile can be modified. 

When a profile is selected, all other Settings tabs refer to the selected 
profile. 

The name of the selected profile is shown in the lower-right corner on 
each tab. See Figure 26.

Figure 26: Profiles screen

AAA1189.bmp



Mobile Voice Client 2050 settings

67

The profiles screen enables you to:

• create profiles

• delete profiles

• modify a profile name

• change the profile used by the application

• export profiles

• import profiles

Creating a new profile
Use the following procedure to create a new profile:

1. Select New. A screen appears with an empty text box labeled Name.

2. Enter the new profile name.

3. Select OK.

The Profiles screen reappears. The new profile is created and selected. 
The values on all the other tabs is set to their defaults for this profile. Any 
value modified on any of the other tabs is associated with this profile, until 
another profile is selected. To change settings on other tabs for this 
profile, select the tab you wish to change. For example, select the Server 
tab from the Settings screen to modify the default server settings. See 
Figure 27 on page 68.
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Figure 27: Selecting a profile  

Removing a profile
Use the following procedure to remove a profile:

1. From the drop-down list on the Profiles tab, select the profile you 
want to remove. See Figure 27.

Note: “My Server” is a built-in profile name that cannot be deleted.

2. Select Remove.

The profile disappears from the list.

Modifying the name of a profile
Use the following procedure to modify the name of a profile:

1. Select the profile you want to change from the drop-down list on the 
Profiles tab. See Figure 27.

2. Select Modify. The profile name appears highlighted.

AAA1190.bmp
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3. Enter the new profile name.

4. Select OK.

The Profiles screen reappears. The new profile is selected.

Changing the current profile
Use the following procedure to select the profile for your MVC 2050:

1. Select the name of the profile you want to change from the drop-down 
list at the top of the Profiles screen.

2. Choose one of the following:

a. If MVC 2050 is running, press Reset. The application 
disconnects from the current server, and attempts to connect to 
the server defined by the newly selected profile. 

b. If MVC 2050 is not running, press OK. The next time the 
application starts, it uses the selected profile.

Note 1: To modify the profile itself, select the profile, and select the 
tabs you wish to change.

Note 2: The application briefly indicates which profile is in use as it 
starts up. 

Exporting profiles
Use the following procedure to export a profile to a file:

1. Select Export. A dialog box appears. 

2. To save as a file, select “Export to a file”.

3. Select OK.

4. Enter a file name.

5. Use the folder object to select a directory. 

6. Select OK.

Note: To keep the profile as a backup, copy the profile to your 
desktop PC using ActiveSync.
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Use the following procedure to export a profile to another device:

1. Select Export. A dialog box appears. 

2. To export to another device, select “Export to another device”.

3. Select OK.

4. Align the infrared ports of the two devices. The profile is exported to 
the other device.

Note: When exporting a profile, the Hardware ID is also included with 
the profile information and must be cleared when the profile is 
imported to another device. For more information on Hardware IDs, 
see “Hardware ID” on page 82

Importing profiles
Use the following procedure to import a profile from a file:

1. Select Import. A dialog box appears. 

2. To Import from a file, select “Import from a file”.

3. Select OK.

4. Use the file explorer to locate the file containing the profile. 

5. Select Cancel or Select.

6. Select OK.

7. Select the profiles to import. 

8. Select Cancel or Select.

9. Select OK.

Use the following procedure to import (beam) a profile from another 
device:

1. Select Import. A dialog box appears. 

2. To Import from another device, select “Import from another device”.

3. Select OK.

4. Align the infrared ports of the two devices.

5. Select the profiles to be imported.
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Server

The Server tab contains all of the settings that enable MVC 2050 to 
contact a communication server. See Figure 28 on page 71.

Your system administrator sets up your LAN server to direct your 
MVC 2050 to the communication server.

Figure 28: Server screen  

When you want to connect to your home office communication server 
rather than the local office server, if you are not using a Dynamic Host 
Configuration Protocol (DHCP) server, you can create a profile to manage 
the connection. 

This profile contains the IP address of the server to which you want to 
connect, as well as the server port number and type. For more 
information about creating and selecting a profile, see “Profiles” on 
page 66.
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If your system is set up with DHCP, the primary and secondary server 
addresses both are assigned by way of DHCP, and no action is required. 
See Figure 29 on page 72.

Figure 29:  DHCP Setting on the Server screen

Macros

The Mobile Voice Client (MVC) 2050 Macros tab enables you to record 
and use macros. A macro is a recorded sequence of steps that saves you 
keystrokes. 

For example, you can create a macro that selects a particular line, and 
then dials that telephone number automatically. Another example of 
macro use is programming voicemail access numbers and codes for 
faster access.

See Figure 30 and Figure 31 on page 74.
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Figure 30: Keys > Macros menu

Macro screen
To enter a new macro name, or to select an existing macro to modify or 
delete, select the New icon to the right of the list box. See Figure 31.

To select an existing macro, tap the down arrow in the Macro list box, and 
make your selection. 

To delete a selected macro, tap the Delete icon, the button to the right of 
the list box.
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Figure 31: Macro screen

Keys
Once you have selected a macro name, tap the down arrow in the Keys 
drop-down list to select a key to add to the macro. Press the Add button 
to add the key. 

The Pause key is used to insert a short pause in the macro. A pause 
introduces a delay, which is required to access some Interactive Voice 
Response (IVR) applications and the voicemail systems.

Contents
A list of the macro contents appears in the Contents list box. When two 
or more entries are in this box, the keystrokes can be moved around by 
using the up and down navigation buttons, which appear to the right of the 
box.

You can remove keystrokes from the Contents box by selecting a 
keystroke, and pressing the Remove button.

Delete

Dialpad 

New
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Preview
You can preview your macro in a single view by viewing the Read-only 
field under the Contents box. 

Dialpad
You can select the Keys list box and press the Add button, or you can 
use the numbers on the dialpad, to enter numbers into your macro.
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Mobile Voice Client 2050 for 
expert users

This section discusses the selections used to diagnose or correct error 
conditions, and are not used during normal operation of Mobile Voice 
Client 2050.

Client diagnostics

Client diagnostics are used to determine the connection status of the 
MVC 2050. Access client diagnostics from the Help > Diagnostics 
screen. See Figure 14 on page 30. 

Diagnostics include: 

• Ping

• TraceRoute

• RUDP Ping 

Ping tests whether the network destination in online.

TraceRoute is an operation for sending trace packets to trace the route of 
user datagram protocol (UDP) from local host to remote host.

RUDP Ping tests if the IP port is responding as a terminal proxy server 
(TPS).

See also “Profiles” on page 66 for information on changing, importing, 
and exporting profiles to assist in troubleshooting.
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Audio quality

Audio quality of voice transmission depends on many factors, such as 
codec characteristics, echo canceller, jitter buffer size, and listener 
perception. 

Audio quality is controlled from two screens: 

• Audio, the quality slider tab

• Advanced Audio (for expert users)

Audio quality slider
You can control audio quality by using the slider tab to reduce audio delay 
and increase audio clarity. See Figure 32. The slider controls the number 
of audio buffers the PDA uses to smooth out incoming audio streams.

Figure 32: Audio quality screen
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Audio delay
If you experience audio delay, you can decrease the number of buffers, 
and reduce the delay, by adjusting the slider on the Audio screen. 

Audio clarity
If you experience breakups in the receive audio stream, adjust the setting 
towards Higher Quality. This increases the number of audio buffers used 
to process incoming audio. If the delay is too large, you can decrease this 
setting.

If you experience broken or choppy speech at either end of the call, or if 
the dial tone sounds choppy, avoid using your PDA volume control. 
Instead, use the volume controls on the MVC 2050 toolbar to adjust the 
volume of your call.

Note: QoS 802.11 p/q is not supported due to device constraints.
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Advanced Audio
Advanced audio settings are recommended for use only by advanced 
users. See Figure 33 on page 79. 

NetEQ software, included with the MVC 2050 software, provides loss 
concealment and compensation; NetEQ is the default setting. 

You cannot adjust the MVC 2050 Advanced Audio settings. 

Figure 33: Advanced Audio screen
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Items on the Advanced Audio screen 
Table 7 describes the selections available on the Advanced Audio screen. 

Table 7: Advanced Audio screen

Selection Description

NetEQ (Global IP Sound) NetEQ packet loss concealment 
software is the default mode of 
operation. 

Jitter Buffer The rate of arrival of voice frames is 
variable. A jitter buffer is used to 
minimize this variability by sending voice 
frames to your PDA sound system at a 
fixed rate. The value of “jitter” is the 
number of voice frames the application 
has in its jitter buffer. 

Highwater Mark Highwater mark indicates the maximum 
number of voice frames the application 
can have in its jitter buffer, before it starts 
discarding packets. Set this value to at 
least 2.5 times the value of jitter. 

Early Packet and Late 
Packet Resync

Early Packet Resync and Late Packet 
Resync indicate the points at which 
MVC 2050 discards and restarts the jitter 
buffer contents. Set this value to at least 
5 times the highwater mark. 
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Listener IP

See Figure 34. This screen is for expert users only. It can be used to 
override the port assignments when a conflicting application is on the 
PDA.

Figure 34: Listener IP screen
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Items on the Listener IP screen
Table 8 describes selections available on the Listener IP screen.

Hardware ID

The Hardware ID screen is for expert users and system administrators. It 
can be used to select the Media Access Control (MAC) address that the 
MVC 2050 reports to the communication server.

The Hardware ID being used by MVC 2050 can be viewed on the 
MVC 2050 Settings > Hardware ID tab. See Figure 35 on page 83.

Table 8: Listener IP screen

Selection Description

Use a specific 
address

The MVC 2050 normally listens to all IP 
addresses on the device for communication 
server-to-terminal (UNIStim) messaging on all the 
Network Interface Cards (NIC) on the device. This 
is the default mode of operation. To override this 
behavior, select the check box, and enter a 
specific IP address.

Use a specific 
port

The MVC 2050 listens to IP port 5000 on the 
device for communication server-to-terminal 
(UNIStim) messaging.
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Figure 35: Hardware ID screen

The Hardware ID is generated by reading MAC addresses from the PDA 
NIC. When the MVC 2050 is used with most server types, the Hardware 
ID it uses must be unique. Some software, such as VPN client software, 
creates artificial network interfaces with MAC addresses that are common 
to all installations of the software. As a result, the MAC address is the 
same on many different computers.

Without a unique MAC address, users sometimes are unable to connect 
to a server, or will connect to a server, and subsequently cause another 
device with the same Hardware ID to be disconnected from the server. If 
the MVC 2050 is disconnected from the server, it automatically attempts 
to reconnect, and the resulting conflicts will prevent a stable connection 
from being made.

Select the Auto-Create button on the Settings > Hardware ID screen to 
prevent conflict with another device. Auto-Create fabricates a random 
value, which is unlikely to be repeated by another device.

AAA1207.bmp
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Table 9 describes items on the Hardware ID screen. 

Connection history

Connection history writes indication messages to the registry key 
“\HKCU\Software\Nortel Networks\MVC2050\Log” for connection or 
disconnection events. This is a circular queue of 29 entries. 

Each time a connection or disconnection event occurs, a log entry is 
written. The entries contain a date and time, and a description of the 
connection or disconnection event. 

The following section describes connection and disconnection events.

Table 9: Hardware ID screen

Selection Description

Hardware ID This box contains the MAC address for the Ethernet 
hardware installed in your device. MVC 2050 uses the 
MAC address of the Ethernet hardware as its 
Hardware ID. You can change this value if there is 
more than one MAC address, or if the device is using 
an Extranet client that hides the true MAC address. 
For example, the Nortel Contivity Extranet Switch 
uses a single MAC address for all clients. This can 
cause connection problems with your communication 
server.

Auto-Create This changes the MAC address that appears in the 
Hardware ID box. If your device has more than one 
MAC address, press the Auto-Create button to cycle 
through the set of MAC addresses on your computer. 
Auto-Create also makes up random Hardware IDs, in 
case the Ethernet hardware addresses are not unique 
to the communication server.

Firmware 
Version

Shows the build number of MVC 2050 installed on 
your device. This value is the version number of the 
application last reported by the server.
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Soft reset, server n
This message indicates that the server has instructed the MVC 2050 to 
reset and connect to a server n, where the value of n is determined, and 
possibly written, by the server. This maps directly to a UNIStim message.

Server connected
This message indicates that the MVC 2050 has connected successfully to 
the server. It means that the MVC 2050 received the “AssignTerminalID” 
UNIStim message, which is the last message received by the MVC 2050 
before a normal session commences.

Recovering: Server unreachable
This message is generated when the MVC 2050 has lost its connection 
with the server. It indicates that the UNIStim “watchdog timer” has 
expired. This indicates loss of network connection.

Hard Reset
This message indicates that the server has instructed the MVC 2050 to 
reset and clear its UNIStim-related memory. This maps directly to a 
UNIStim message.
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WiFi

You can ActiveSync your PDA with your PC using WiFi.

WiFi use for a cradled PDA
If you do not want to lose the MVC 2050 connection to the server when 
you return the PDA to its cradle, deactivate ActiveSync. Otherwise, the 
connection is lost, because ActiveSync uses Point-to-Point Protocol 
(PPP). This causes the PDA connection to the network to be dropped, 
and then connected to the PC.

Application Server Administration
This feature is available for your system administrator. The Personal 
Directory, Redial List, and Callers List features use a separate, central 
database, called the Application Server, to store directory data and user 
profile options. Your system administrator can back up and restore the 
database, and manage user profiles, using the Application Server 
Administration feature. 
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